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Thank you for purchasing a Lexmark X1100 Series
All-In-Onel

Congratulations on your purchase. The Lexmark™ X1100 Series
All-In-One combines the functionality of an inkjet printer, a scanner, a
copier, and a fax machine all into a single, multifunction device, making it
one of the most exciting products on the market today.

This guide tells you how to perform printing, copying, scanning, and faxing
tasks. Also included are sections describing the All-In-One software and
troubleshooting information.



Learning about the All-In-One

Setting up the All-In-One

If you have not already done so, follow the steps on the Setup Sheet to
complete the hardware and software installation. If problems occur during
the setup process, see “Setup troubleshooting” on page 20.

Understanding the parts of the All-In-One
Paper guide

Slide next to paper to
ensure proper feeding. Paper support

Lift to load paper into
the All-In-One.

Control panel

Use the buttons to operate the
All-In-One (see page 2 for details
about each of the buttons).

Top cover . Scanner unit
Lift to place an item on Paper exit tray Lift to access the print
the scanner glass. Extend to hold paper as cartridges.

it exits the All-In-One.



USB cable connector

USB cable

Power supply

Silver, metal contacts are on the
left side of the power supply.

Using the control panel

The All-In-One has a control panel that lets you scan and copy with the
press of a button.

Power button

Press to turn the All-In-One
on and off.

Scan button

Press to start the scanning
process and open the
All-In-One Center.

Paper Feed button

Press to feed paper
through the All-In-One.

Black Copy button

Press to make a black and
white copy.

Color Copy button
Press to make a color copy.

Note: Both the computer and the All-In-One must be turned on
to make copies.



Understanding the software

The All-In-One software consists of four main components:

The Lexmark X1100 Series All-In-One Center (scanning, copying,
and faxing)

Print Properties (printing)

The Lexmark X1100 Series Solution Center (troubleshooting,
maintenance, and cartridge ordering information)

The Lexmark Photo Editor (editing graphics)

Using the Lexmark All-In-One Center

Use the Lexmark X1100 Series All-In-One Center software to scan, copy,
and fax documents. There are three ways to open the All-In-One Center:

Click Start » Programs » Lexmark X1100 Series »

Lexmark All-In-One Center.

Double-click the Lexmark X1100 Series All-In-One Center icon on
the desktop.

Press Scan on the control panel. For more information about using
the control panel, see page 2.

The All-In-One Main Page displays.

Preview section

All-In-One Center
All-In-One Main Page

Scan section
//

| — Copy section

| — Creative Tasks
— b
section




The All-In-One Main Page

The All-In-One Main Page consists of four main sections: Scan, Copy,
Creative Tasks, and Preview.

From this section: You can:

Scan * Select a program to send the scanned image to.
* Choose what type of image is being scanned.
* Choose how the scan will be used.

Note: Click See More Scan Settings to view all
settings.

Copy « Select the quantity and color of your copies.
« Select a quality setting for your copies.

« Adjust the size of the scanned area.

« Lighten or darken your copies.

« Enlarge or reduce your copies.

Note: Click See More Copy Settings to view all
settings.

Creative Tasks Choose from a variety of creative ideas.

Enlarge or reduce an image.

Repeat an image several times on one page.
Print an image as a multi-page poster.

E-mail an image to a friend.

Fax using your computer's modem.

Save an image on my computer.

Edit text found in a scanned document (OCR).
Modify an image with a photo editor.

Preview section « Select a region of the preview image to scan.
* View an image of what will be printed or copied.

Note: For more information about the All-In-One Main Page,
click the Help button located in the upper right corner of
the screen.



View Saved Images page

Use the View Saved Images page to perform tasks with images that are
saved on the computer. The View Saved Images page consists of three

sections.
From this section: You can:
Open with... Select a program to send the saved image to.
Print a Copy... * Choose the quantity and color of your copies.

« Select a quality setting for your copies.
¢ Lighten or darken your copies.
« Enlarge or reduce your copies.

Note: Click See More Copy Settings to view all
settings.

Creative Tasks Select from a variety of creative ideas. For help, see

page 4.

Note: For more information about this page, click the Help
button located in the upper right corner of the screen.

Maintain/Troubleshoot page

The Maintain/Troubleshoot page provides you with direct links to the
Lexmark Solution Center. Choose from these topics:

Maintain or fix quality problems

Troubleshoot All-In-One problems

Device status and ink levels

More printing ideas and how to’s

Contact information

Advanced (skin, voice, and communication options)
View the software version and copyright information

For more information about the Lexmark Solution Center, see page 8.

Note: For more information about this page, click the Help
button located in the upper right corner of the screen.



Using Print Properties

Print Properties is the software that controls the All-In-One printing
function. You can change the settings in Print Properties based on the type
of project you want to create. You can open Print Properties from almost
any program:

1 From the program File menu, click Print.

2 Inthe Print dialog box, click the Properties, Preferences, Options,
or Setup button (depending on the program).

The Print Properties screen displays.

Note: Some programs open Print Properties differently.

Print Properties
Quality Copies tab and | Want To menu

Lexmark X100 Series m:{
SaveSetings v |[WentTo v  Oplions v

[
Print Properties Quatty/Copies | Want To menu
tabs Notmal ;:3 /

s L Select one of the
Use the Quality/ — projects from the
Copies, Paper s {T . menu to help
Setup, and Print &, S print photos,
LayOUt tabs t.o Gl ' ; 7 Show This Menu at Statup. banners’
select the print e “ o E—— envelopes,
settings. o =5 = posters, and

T— more.

LEXM,\RK Cancel Help

The | Want To menu

The | Want To menu displays when you open Print Properties. It contains a
variety of task wizards to help you select the correct print settings for your
project. Close the menu for a full view of the Print Properties dialog box.



Print Properties tabs

All of the print settings are on the three main tabs of the Print Properties
software: Quality/Copies, Paper Setup, and Print Layout.

From this tab: You can change these settings:

Quality/Copies Quality/Speed — Select a Quality/Speed setting.

Multiple Copies — Customize how the All-In-One prints
several copies of a single print job: collated or normal.

Print Color Images in Black and White — Select this to
print color images in black and white.

Paper Setup Type — Select the type of paper you are using.
Paper Size — Select the size of the paper you are using.

Orientation — Select how you want the document
oriented on the printed page: portrait or landscape.

Print Layout Layout — Select the layout you want to print.

Duplexing — Select this when you want to print on both
sides of the paper.

Note: For additional information about these settings,
right-click a setting on the screen, and then select the
What'’s This? item.

Save Settings menu

From the Save Settings menu, you can name and save the current Print
Properties settings for future use. You can save up to five custom settings.

Options menu

Use the Options menu to make changes to the Quality Options, Layout
Options, and Printing Status Options settings. For more information on
these settings, open the tab dialog box from the menu, and then click the
Help button on the dialog box.

The Options menu also provides you with direct links to different parts of
the Lexmark Solution Center (see page 8), as well as software version
information.



Using the Lexmark Solution Center

The Lexmark X1100 Series Solution Center is a valuable information
resource. To open the Lexmark Solution Center, click Start » Programs »
Lexmark X1100 Series » Lexmark X1100 Series Solution Center.

The Printer Status tab displays.
Lexmark Solution Center

Printer Status tab

— Printer Status

Ink levels

The Lexmark Solution Center consists of six tabs: Printer Status, How To,
Troubleshooting, Maintenance, Contact Information, and Advanced.

From this tab: You can:

Printer Status (Main |+ View the status of the All-In-One. For example, while
dialog box) printing, the status is Busy Printing.

« View the ink levels of the print cartridges.

How To Learn how to:

« Scan, copy, fax, and print.
¢ Find and change settings.

* Use basic features.

« Print projects such as banners and iron-on transfers.

Troubleshooting < Learn tips about the current status.
¢ Solve All-In-One problems.

Maintenance « Install a new print cartridge.

Note: Wait until scanning is complete before installing
new cartridges.

* View shopping options for new cartridges.

« Print a test page.

* Clean to fix horizontal streaks.

« Align to fix blurry edges.

e Troubleshoot other ink problems.

* Remove Japanese postcard residue.
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From this tab: You can:

Contact Information

« Learn how to contact Lexmark by phone, e-mail, or on
the World Wide Web.

Advanced

« Change the appearance of the Printing Status window
and turn printing voice notification on or off.

¢ Obtain software version information.

Note:

For more information, click the Help button located in
the lower right corner of the screen.

Using the Lexmark Photo Editor

Use the Lexmark Photo Editor software to edit graphics. To open the

Lexmark Photo Ed

itor, click Start » Programs » Lexmark X1100

Series » Lexmark Photo Editor.

The Lexmark Photo Editor displays.

Use the touch-up tools to edit your graphic.

Move your pointer over the tool for a description.

Touch-up tools

Lexmark Photo Editor




Using the All-In-One

The following sections give you everything you need to know for basic
printing, scanning, copying, and faxing.

Printing

The Print Properties | Want To menu (see page 6) provides you with
printing wizards to help you complete tasks such as printing banners,
photographs, or posters.

1 Depending on what you want to print, load the appropriate type of
paper into the All-In-One. Place the paper against the right side of
the paper support with the print side facing you. Make sure you
select the paper size for your document. For help, see page 12.

——

i

Load up to:

¢ 100 sheets of plain paper 20 sheets of banner paper

e 25 sheets of labels 10 sheets of greeting card stock

e 25 iron-on transfers 10 Hagaki cards

¢ 25 sheets of photo/glossy paper 10 envelopes

« 10 transparencies Note: Do not load envelopes with:

* Holes, perforations, cutouts, or

Note: Since transparencies and .
deep embossing.

photos require more drying time, we

recommend that you remove each ¢ Metal clasps, string ties, or
transparency or photo as it exits and metal folding bars.
allow to dry to avoid ink smearing. * Exposed flap adhesive.

10



2 Squeeze and slide the paper guide to the left edge of the paper.

3 Make sure the All-In-One is turned on.
Click File » Print.

In the Print dialog box, click the Properties, Preferences, Options,
or Setup button (depending on the program).

The Print Properties dialog box displays.

6 If the printing task you want to perform is on the | Want To menu,
click it, and then follow the instructions on the computer screen;
otherwise, click Close at the bottom of the menu.

7 From the Quality/Copies tab, select the quality, speed, and copy
settings.

To see details about a setting, right-click a setting on the screen,
and then select the What’s This? item.

Lexmark X1100 Series =[]

Quality/Speed

settings Copy

/ settings

b

§
G




8 From the Paper Setup tab, select the paper type, paper size, and
orientation.

To see details about a setting, right-click a setting on the screen,
and then select the What's This? item.

Lexmark X1100 5 eries z]

Save Sellings v |WentTo Options +.

Paper type
setting

Paper size
setting

Quality/Copies.

0 Executive (71741 101721
o Inde Card (3 551

a Fostcard (41 6in)

[ 44 (210 % 257 o)

0 85 (162 x257

& 45 (149 x210 mml

& Statement (51/2x81/2in)
9 ABCad (105414 mm) v

| —— Orientation
setting

 Fotat

LIF € Landsoape

9 From the Print Layout tab, select the layout and duplexing settings
for the type of document you are printing.

To see details about a setting, right-click a setting on the screen,
and then select the What’s This? item.

. | — Layout
setting

¢

Quality/Copies.
i

Qualty =i
Normal ==
Colste é

on =

lalie e Tl Tia N}

Paper Setup

Tipe

Plin A
size

Lot =

_|— Duplexing

plosing setting
Print Layout
I~ TwoSided
Piint Layou
Norml % v
Iuosided :\F £ G ) ’\/ ook
LE)GVI.\RK oK Cancel Help

10 Once you have applied all the settings you want in Print Properties,
click OK at the bottom of the screen to return to the Print dialog box.

11 Click Print to complete your task.

12



Scanning

The following steps show you how to scan and save images.

1 Open the top cover of the All-In-One.

2 Place the item you want to scan face down on the glass. Make sure
the upper left corner of the front of the item aligns with the arrow.

3

Close the top cover.
Open the Lexmark All-In-One Center (see page 3).
The All-In-One Main Page displays.

5 Click the Preview Now button located in the upper right corner of
the All-In-One Main Page.

An image of the scanned item displays in the preview section.

6 Click and drag to select a specific area of the preview image to
scan.

7 Click See More Scan Settings to review and change the scan
settings.

8 Select your scan settings.

13



From the Send scanned image to: drop-down menu, select a
program to send the scanned image to, or click the Creative Tasks
section to display a list of projects.

Preview Now button

Click to see a preview
of the image.

Scan Now button
Click to scan the item
on the scanner bed.

Scan settings
How will the scan be used?

ot oG 15007) | Adjust the settings for
the scanned item.

Copy.
a Lo

s ]

Creative Tasks
2 See Cresive Tasks ]

an Previen

/

Preview section

See a preview of the image, and select an area to be
scanned.

9 If you are sending the scanned image to a software program, click
Scan Now to complete the scan. If you are using the Creative
Tasks section, follow the instructions on the computer screen.

For a list of the Creative Tasks available from the All-In-One Main
Page, see page 4.

Copying

Note: You can make a quick color or black and white copy.
Press Color Copy or Black Copy on the control panel.

To make black and white, gray, or color copies:

1 Open the top cover of the All-In-One.

14



2 Place the item you want to copy face down on the glass. Make sure
the upper left corner of the front of the item aligns with the arrow.

=3

Close the top cover.
Open the Lexmark All-In-One Center (see page 3).
The All-In-One Main Page displays.

5 Click See More Copy Settings to review and change the copy
settings.

The All-In-One Copy section expands:

— “| __— Preview Now button
Click to see a preview of the image.

| Copy Now button
Click to copy your image.

Copy settings
Adjust the settings for the copy.

Preview section
See a preview of the image, and select an area to be copied.

6 Select your copy settings.
Note: You may want to reduce or enlarge the image.

7 Click Copy Now.

15



Faxing

The following steps lead you through sending a fax using the computer
modem.

1 Open the top cover.

2 Place the item you want to fax face down on the glass. Make sure
the upper left corner of the front of the item aligns with the arrow.

Close the top cover.
Open the Lexmark All-In-One Center (see page 3).

5 From the Creative Tasks section of the All-In-One Main Page, click
Fax an image.

6 Follow the instructions on the computer screen.

16



Maintenance

Replacing the print cartridges

The Lexmark X1100 Series has been designed to print using the following
cartridges.

Item: Part number:

Standard yield black cartridge 16
Standard yield color cartridge 26
Moderate use black cartridge 17
Moderate use color cartridge 27

Note: You can print using only the color cartridge, or with both
a color cartridge and a black cartridge.

For information about ordering supplies, see page 8.

Before you install new or replacement print cartridges, remove the used
cartridges.

1 Make sure the All-In-One is on.
2 Lift the scanner unit until the scanner support keeps it open.

The print cartridge carrier moves and stops at the loading position
unless the All-In-One is busy.

Squeeze the tabs on the cartridge lids, and then lift the lids.

Remove the old cartridges. Store them in an air-tight container or
dispose of them.

5 If you are installing new cartridges, remove the stickers and
transparent tape from the bottom of the cartridges.

Warning: Do not touch the gold contact area on the cartridges.

17



6 Insert the new cartridge. Make sure the color print cartridge is
secure in the left carrier and then snap the lid closed.

If you are installing a black print cartridge, make sure that it is
secure in the right carrier, and then snap the lid closed.

7 Lift the scanner unit and push the scanner support back while
lowering the scanner unit until it is completely closed.

Lexmark’s All-In-One warranty does not cover repair of failures or damage
caused by a refilled cartridge. We do not recommend use of refilled
cartridges. Refilling cartridges can affect print quality and cause damage to
the All-In-One. For best results, use Lexmark supplies.

18



Troubleshooting

This section helps you solve problems you may have with the All-In-One.
Additional troubleshooting information is available in the Lexmark Solution
Center. For help accessing the Lexmark Solution Center, see page 8.

Troubleshooting checklist

Before you try to solve the problem, check the following:

Is the power supply firmly attached to the All-In-One and an
electrical outlet?

Are both the computer and All-In-One on?

RN

Is the USB cable securely attached to the computer and the
All-In-One?

[<]

Did you remove the sticker and transparent tape from the print
cartridge? For help, refer to the setup documentation.

Is the color cartridge secure in the left carrier?
Is the black print cartridge secure in the right carrier, if you
installed both?

RN

Is the paper loaded correctly? Make sure you do not force the
paper into the printer.

<]

Did you install the printer software correctly? For help, refer to the
setup documentation.

[<]

Is the Lexmark X1100 Series set as the default? To check, click
Start » Settings » Printers. If not, you need to remove and then
reinstall the software. For help, see page 26.

<]

19



Problem: Go to page:

Power light does not come on 20
Alignment page does not print 21
When | insert the All-In-One software CD, nothing 21
happens

All-In-One is hot communicating with the computer 21
Installation appears incomplete 21
All-In-One prints slowly 22
Print is too dark or smudged 22
Vertical lines are jagged or edges are not smooth 23
White lines appear in graphics or solid black areas 23
All-In-One has a paper jam 23
Scanning was not successful 24
Scanning or using a scanned image with a software 24
program takes a long time or freezes the computer

Edge of the copy does not print 24
Copy button on the control panel does not work 25
Fax function does not work 25

Setup troubleshooting

Use this section to solve problems you may have during setup.

Power light does not come on

1 Check the power supply connections.

2 Press Power on the control panel.

20



Alignment page does not print

1 Make sure you remove the sticker and transparent tape from the
print cartridges. For help installing print cartridges, refer to the
setup documentation.

2 Make sure the color cartridge is secure in the left carrier.

Make sure the black print cartridge is secure in the right carrier if
you installed both.

3 Make sure you loaded the paper correctly and did not force the
paper into the All-In-One.

When | insert the All-In-One software CD, nothing
happens

From the Desktop, double-click the My Computer icon, and then
double-click the CD-ROM drive icon.

All-In-One is not communicating with the computer

1 Disconnect and reconnect both ends of the USB cable. For help,
refer to the setup documentation.

2 Unplug the All-In-One from the electrical wall outlet, reconnect the
power supply, and then press Power. For help, refer to the setup
documentation.

3 Restart the computer. If the problem continues, remove and then
reinstall the software. For help, see page 26.
Installation appears incomplete
The software may not be installed properly. Try the following:

1 Right-click the My computer icon.
Windows XP users, click Start to access the My computer icon.

2 Click Properties.

21



3 If you are using Windows 98 or Windows Me, click the Device
Manager tab.

If you are using Windows 2000 or Windows XP, select the
Hardware tab, and then click Device Manager.

4 Look for the Other Devices category. If there are any Lexmark
devices shown here, highlight them and then press the Delete key.

Note: The Other Devices category displays only when
unknown devices are present. Do not delete any
Lexmark items unless they are present under the Other
Devices category.

5 Insert the CD, and install the software again. Do not restart the
computer. For help, refer to the setup documentation.

Printing troubleshooting

All-In-One prints slowly

Close all programs not in use. The memory resources may be low.

2 Make sure the Print Properties Quality/Speed setting is set on
Normal or Quick Print. For help, see page 7.

3 Try printing a smaller file. If the memory resources are too low, you
may not be able to print larger files. Consider purchasing more
memory.

Note: Photographs typically have a larger file size. Try
lowering the scanning resolution.

Print is too dark or smudged

1 Remove the paper as it exits. Let the ink dry before handling.

2 Adjust the Quality/Speed setting in Print Properties or in the
All-In-One Center. For help, see page 6 or page 4.
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The Better or Best Quality/Speed setting may cause smearing if
used with plain paper. Try using Normal.

3 Open the Lexmark Solution Center. For help, see page 8.

From the Maintenance tab, click Clean to fix horizontal streaks.

Vertical lines are jagged or edges are not smooth

1 Adjust the Quality/Speed setting in Print Properties. For help, see
page 7. For best print quality, select Better or Best.

2 Align the print cartridges. To align the print cartridges:

a Open the Lexmark Solution Center. For help, see page 8.
b From the Maintenance tab, click Align to fix blurry edges.

White lines appear in graphics or solid black areas

Clean the print cartridge nozzles. Going long periods without using the
All-In-One can cause the print cartridge nozzles to become clogged. To
clean the cartridge nozzles:

1 Open the Lexmark Solution Center. For help, see page 8.

2 From the Maintenance tab, click Clean to fix horizontal streaks.

All-In-One has a paper jam

Follow the instructions on the screen for clearing the paper jam.

2 Make sure you are using paper designed for an inkjet printer. For a
list of recommended papers, see page 10.

3 Make sure you are correctly loading the paper. For help, see
page 10.

4 Make sure the paper guide is against the left edge of the paper. For
help, see page 11.

23



Scanning, copying, and faxing troubleshooting

Scanning was not successful

The software may not be installed properly. Follow the instructions for
“All-In-One is not communicating with the computer” on page 21.

Scanning or using a scanned image with a software
program takes along time or freezes the computer

Lower the scanning resolution. Scanning resolution is much different than
printing resolution and is generally set much lower. To change the scanning
resolution:

1 Open the Lexmark All-In-One Center. For help, see page 3.
2 From the Scan section, click See More Scan Settings.

3 Click Display Advanced Scan Settings.
4

From the Scan tab of Advanced Scan Settings, enter a lower scan
resolution.

Edge of the copy does not print

* Make sure the original is properly oriented on the glass. For help,
see page 13.

* Make sure the area you want to copy is not larger than the printable
area of the page. Apply the Fit-to-page feature. To apply the
Fit-to-page feature:

1 Open the Lexmark All-In-One Center. For help, see page 3.
2 From the Copy section, click See More Copy Settings.

3 From the Reduce/Enlarge section, click the second button, and
then select Fit to page from the corresponding drop-down
menu.

4 Copy your document again.

24



Copy button on the control panel does not work

* Make sure the computer is on. The computer must be on in order
for the All-In-One to work.

* Make sure you properly installed the software. For help, refer to the
setup documentation. The software must be installed for the copier
to work.

Fax function does not work

* Make sure the computer and the All-In-One are on.

* Make sure the computer is connected to a phone line. A phone
connection is required for faxing to function.

* The memory may be full. Wait until the faxes in memory have been
sent, and then send the current fax again.

25



Removing and reinstalling the software

If the All-In-One software is not functioning properly or a communications
error message displays when you try to use the All-In-One, you may need
to remove and then reinstall the printer software.

1

From the desktop, click Start » Programs »
Lexmark X1100 Series » Uninstall Lexmark X1100 Series.

Note: If Uninstall is not an option on the menu, see “All-In-One
is not communicating with the computer” on page 21.

Follow the instructions on the computer screen to remove the
All-In-One software.

Restart the computer before reinstalling the software.

Insert the CD and follow the instructions on the computer screen to
install the software. For help, refer to the setup documentation.

Other help sources

If the preceding solutions do not solve the problem with your All-In-One:

Refer to the Lexmark Solution Center software for more
troubleshooting information:

1 Click Start » Programs » Lexmark X1100 Series »
Lexmark X1100 Series Solution Center.

2 Click the Troubleshooting tab on the left side of the screen.
Visit our Web site at http://support.lexmark.com/ for help.
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Electronic emission notices

Federal Communications
Commission (FCC) compliance
information statement

The Lexmark 3100 Series
4476-K01 has been tested and
found to comply with the limits for a
Class B digital device, pursuant to
Part 15 of the FCC Rules.
Operation is subject to the following
two conditions: (1) this device may
not cause harmful interference, and
(2) this device must accept any
interference received, including
interference that may cause
undesired operation.

The FCC Class B limits are
designed to provide reasonable
protection against harmful
interference in a residential
installation. This equipment
generates, uses, and can radiate
radio frequency energy and, if not
installed and used in accordance
with the instructions, may cause
harmful interference to radio
communications. However, there is
no guarantee that interference will
not occur in a particular installation.
If this equipment does cause
harmful interference to radio or
television reception, which can be
determined by turning the
equipment off and on, the user is
encouraged to try to correct the
interference by one or more of the
following measures:

« Reorient or relocate the
receiving antenna.

* Increase the separation
between the equipment and
receiver.

» Connect the equipment into an
outlet on a circuit different from
that to which the receiver is
connected.

« Consult your point of purchase
or service representative for
additional suggestions.

The manufacturer is not
responsible for any radio or
television interference caused by
using other than recommended
cables or by unauthorized changes
or modifications to this equipment.
Unauthorized changes or
modifications could void the user's

authority to operate this equipment.

Note:To assure compliance
with FCC regulations on
electromagnetic interference for

a Class B computing device,
use a properly shielded and
grounded cable such as
Lexmark part number 1329605
for parallel attach or 12A2405
for USB attach. Use of a
substitute cable not properly
shielded and grounded may
result in a violation of FCC
regulations.

Any questions regarding this
compliance information statement
should be directed to:

Director of Lexmark Technology &
Services

Lexmark International, Inc.

740 West New Circle Road
Lexington, KY 40550

(859) 232-3000

Industry Canada compliance
statement

This Class B digital apparatus
meets all requirements of the
Canadian Interference-Causing
Equipment Regulations.

Avis de conformité aux normes
d’Industrie Canada

Cet appareil numérique de la
classe B respecte toutes les
exigences du Réglement sur le
matériel brouilleur du Canada.

European Community (EC)
directives conformity

This product is in conformity with
the protection requirements of EC
Council directives 89/336/EEC and
73/23/EEC on the approximation
and harmonization of the laws of
the Member States relating to
electromagnetic compatibility and
safety of electrical equipment
designed for use within certain
voltage limits.

A declaration of conformity with the
requirements of the directives has
been signed by the Director of
Manufacturing and Technical
Support, Lexmark International,
S.A., Boigny, France.

This product satisfies the Class B
limits of EN 55022 and safety
requirements of EN 60950.

The United Kingdom
Telecommunications Act 1984
This apparatus is approved under
the approval number NS/G/1234/J/
100003 for the indirect connections
to the public telecommunications
systems in the United Kingdom.
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Japanese VCCI notice

COEBIF. BRUBEBEER
BEEERTIBES (VCC) O
B CH DTS 2 BIEHREM®
BTY, COEBIF. RERET
FERAITZZEEZENELTVWET
N COEBNRTIAPTLEY
3 VEEBIOEEL TERINS
& REREZESISRIT LN
HDET,
EUKERBAE ICHE > TIEL WERLD iRk
W LTSV,

ENERGY STAR

The EPA ENERGY STAR Office
Equipment program is a
partnership effort with office
equipment manufacturers to
promote the introduction of
energy-efficient products and to
reduce air pollution caused by
power generation.

Companies participating in this
program introduce products that
power down when they are not
being used. This feature will cut the
energy used by up to 50 percent.
Lexmark is proud to be a participant
in this program.

As an ENERGY STAR Partner,
Lexmark International, Inc. has
determined that this product meets
the ENERGY STAR guidelines for
energy efficiency.
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Index

A

Advanced tab 9
All-In-One Center, see
Lexmark All-In-One

Center

All-In-One Main Page
Copy section 4
Creative Tasks section

4

Preview section 4
Scan section 4

All-In-One status 8

B

banner
printing 6
banner paper 10
banners
printing 6
black and white, printing
in 7
Black Copy button 2
both sides, printing on,
see duplexing

C

card stock 10
cartridges

viewing ink levels of 8
Color Copy button 2
Contact Information tab 9
control panel 2
copies 7
copy settings 4
copying 14
copyright advisory ii

D

duplexing 7

E

edition information i
electrical emission
statement 27
emission statement 27
envelopes
printing 6

F

faxing 16
FCC statement 27

G

glossy paper 10

H

hardware setup
software setup 1
How To tab 8

| Want To

change quality settings
6

change speed settings
6

print a banner 6

print a photo 6

print a poster 6

print an envelope 6

print on both sides of
the paper 6

see more printing
ideas 6
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| Want To menu 6
ink cartridges
viewing ink levels of 8
ink levels
viewing 8
inkjet paper 10
iron-on transfers 10
printing 6

L

labels 10
Lexmark All-In-One
Center 3
opening 3
using 3
Lexmark Solution Center
8
Advanced tab 9
Contact Information
tab 9
How To tab 8
Maintenance tab 8
opening 8
Printer Status tab 8
Troubleshooting tab 8
loading paper 10

M

Maintain/Troubleshoot
page 5

Maintenance tab 8

multiple copies 7

O

orientation, selecting 7

F)
paper



acceptable types of 10
loading 10
paper exit tray 1
Paper Feed button 2
paper guide
adjusting 11
Paper Setup tab 7
parts of your All-In-One 1
photo paper 10
photos
printing 6
scanning 13
poor quality printing 22
posters
printing 6
Power button 2
Preview Now button 13
Preview section
Preview Now button
13
Print/Copy preview 4
Scan preview 4
print cartridges
viewing ink levels of 8
Print Layout tab 7
Print Properties 6
| Want To menu 6
opening 6
Options menu 7
Paper Setup tab 7
Print Layout tab 7
Quality/Copies tab 7
Save Settings menu 7
tabs 7
printing 10
banners 6
envelopes 6
photos 6
posters 6
Printing Status window
changing appearance
of 9

Q

Quality/Copies tab 7

R

reinstalling software 26
removing software 26

S

safety information ii
Save Settings menu 7
saved images
viewing 5
Scan button 2
scan settings 4
scanner unit 1
scanning 13
placing an item on the
glass 13
settings, saving for future
use 7
setup 1
setup troubleshooting 20
software
reinstalling 26
removing 26
sound, see voice
notification
Status tab 8

T

top cover 1
transparencies 10
troubleshooting
copying problems 24
faxing problems 24
scanning problems 24
setup problems 20
troubleshooting checklist
19
Troubleshooting tab 8
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V

View Saved Images page
5
Open with... section 5
Print a Copy...section
5
voice notification
turning on or off 9
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